Stream Habitat Measurement Techniques
U.S. Fish and Wildlife Service, National Conservation Training Center

Water Body Identification, Regional Setting, and
Drainage Catchment Attributes

This packet is your first assignment. We recommend that you save this
document as a .pdf to facilitate toggling between this file and the website links.

Please have this assignment completed before the webinar. We will go over the
answers during the webinar and answer any specific questions you may have.

In addition to in-stream habitat measurements, it is always important to
characterize the sampling site within its larger context. This characterization includes
water body identification (especially location), regional description (e.g., physiographic
province, ecoregion), and drainage catchment size and geomorphic properties. We will
make extensive use of two on-line mappers; the USGS “The National Map Viewer” and
EPA’s “Enviromapper for Water”.

For this assignment, we will take you through the process to characterize a
sampling site using a specific stream location in Maryland. After you have become
familiar with the various tools, then you will do the characterization of the field site we
will be visiting during the week of class. It is very important that you finish this
assignment prior to the webinar as there will be no time to complete it after the class
has begun.

Water Body ldentification

Detailed identification is important for:

« Organization of sample sites in data bases;

« Identification by other data users; and

* Relocation on maps (e.g., GIS) or in the field.
Three forms of documentation:

» Descriptive attributes as name, stream classification (e.g., Rosgen), state
designated use, impairment status (Clean Water Act section 303(d)), ownership,
accessibility, etc.;

« Location coding with a unique number assignment (e.g., HUCs, EPA reach
codes); and

» Position identification (latitude, longitude, UTMs, elevation)
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Position identification (‘exact’ location) :

« Latitude, longitude, and Universal Transverse Mercator (UTM) coordinates define
the location of a point on earth in two-dimensional space (elevation can be used
as well to add the 3" dimension)

+ Latitude, longitude, UTM coordinates, and elevation can be obtained easily from
map viewers on the internet or USGS topographic maps.

« River mile or river kilometer still used, particularly on larger rivers, but less
common overall

Latitude and Longitude-

Latitude and Longitude Coordinate System
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Red Dot: Galveston, Texas is 29°43'00” North & 94°48°00” West

Practical Exercise- (fill out the data form in Appendix 2 as you go through the
exercises, the answers are located in Appendix 4 at rear of this document):

We will now work with the location of the stream sample site. The site is on an
unnamed tributary of Little Antietam Creek.

The position is: Latitude 39.6611° N and Longitude -77.5463° W

These readings are in “decimal degrees” (the coordinates are expressed as decimal
fractions).
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v' Convert latitude and longitude in decimal degrees to degrees, minutes, and
seconds.

There are simple formulas to do this task, however it's even easier to use an internet-
based converter. Go to:

https://www.fcc.gov/media/radio/dms-decimal

Use the lower box to plug in latitude decimal degrees and then longitude decimal
degrees of the sample site to convert to degrees, minutes, and seconds. Enter only
numbers and the negative sign if appropriate, do not enter units (as degrees, minutes).

Record the Answer on your Data Sheet, Appendix 2

*Note that the converter also will convert degrees, minutes, and seconds into
decimal degrees.

v' Convert site position from latitude and longitude to Universal Transverse
Mercator (UTM) coordinates. See Appendix 1: Universal Transverse
Mercator Geographic Coordinate System for an overview of the UTM
coordinate system.

Go to UTM converter: http://www.dmap.co.uk/lI2tm.htm

Enter Degrees, Minutes, and Seconds for the stream site location (numbers only, no
units). Do not enter negative signs for lat/long coordinates west of Greenwich or south
of the equator. Specify W or S instead. Then choose grid area UTM (WGS84 datum)
and select “Calculate” for determining the central meridian longitude. Finally, click the
convert button to derive the Easting, Northing, and Grid Reference. The number(s)
preceding the letters of the Grid Reference is the UTM zone.

Your answer will be the coordinates for the sample site defined as:
Zone# Easting (m) Northing (m)

Record the Answer on your Data Sheet, Appendix 2

*Note: A good way to visualize lat-long and UTM is using Google Earth.
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If you have Google Earth downloaded on your computer:

Open Google Earth > click on “View” menu on upper left > select “grid” > click on
“Tools” > “Options” > select the “3D View” tab > select the “Decimal Degrees” radial
button in middle left of the box. Click “OK”. You'll see the latitude-longitude grid appear
on the globe. You can scroll in and out for a close-up or father-out perspective.

Now, to get the UTM grid, go back to “Tools” > “Options” > select the “Universal
Transverse Mercator” radial button. Click “OK”. You'll see the UTM grid appear, with
zone numbers laterally and zone alphabetical designations vertically.

Now, find the sample site on a map. Go to the USGS National Map Viewer at:
http://viewer.nationalmap.gov/viewer/

Please note: This program can take time to perform functions (load). If load times are
exceedingly long or you are repeatedly getting error messages when you initiate a
function, you may need to change the scale of the map, close unnecessary data layers,
or close the browser and start again. If re-starting doesn’t solve the problem, you may
need to clear your web browser history. In Google Chrome, you would go to the menu
box in the upper right-hand corner > History > History >Clear browsing data... > check
all boxes and clear from “the beginning of time” > Clear browsing data. Also, your
number pad may not function properly; instead use the numbers above the letters on
the main keyboard.
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If you want additional assistance, click on the “Help” link in the upper right-hand corner.

Screenshot of the National Map Viewer
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All tools you will be using are located under the “Toolbox” menu bar at the top of the
map.

Standard | Advanced | Annotation | Active Tool: None (Map Navigation)

N4 K Q@& & <O w

Under the “Standard” tab of the menu bar, @ Xt K @ & & - s

W i s A

Map Navigation icon ( ): must be selected when zooming, scrolling, and
moving around map.

Identify icon (¥ ): used for obtaining stream or watershed information such as
hydrologic unit codes (HUCs)

Find Coordinates icon ( ** ): is a location identifier

Clear Graphics icon ( ): important; same as “Clear Map” link on top right of
viewer; must use this tool to remove map information from a previous query
before continuing; otherwise, the program will operate slowly.

Reset Zoom & Zoom icons ( P & ¢

")

Spot Elevation icon ( ): used to determine 1) elevation of any map point, and
2) stream reach codes.

We will not be using the “Download Data”, “Download by Bounding Box”, and
“Bounding Box from Coordinates” icons

Under the “Advanced” tab (will only mention two icons),

Measure Distance icon ( ' ): use to measure linear distance between two
points.

Measure Area icon ( ): used to measure area, specifically catchment
drainage area in our case.
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Note: make sure that your selected icon is labeled as the “Active Tool:” located in the
menu bar. For example, select the map navigation icon , and the legend should be

Active Tool: None (Map Navigation)

Go to the search box at the top, enter the latitude and longitude coordinates in decimal
degrees (separated by a space and do not include the degree symbol or letter
designations) for the unnamed tributary of Little Antietam Creek. Click “Search”.

Latitude 39.6611° N and Longitude -77.5463° W
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If you zoom out (by using the zoom bar on the upper left of the map), note that two
locations appear: one in the northern hemisphere and one in the southern hemisphere.
This is because the map-viewer will not allow N, S, E, or W designations. We are
interested in the northern hemisphere site (A). Click “Zoom To” under point “A” to enlarge
sampling site. To find the sampling site elevation, go to the panel on the left and click
"More" and select elevation and record answer. Note: This is the elevation number you will
use throughout the entire assignment.
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The study site location, marked by a circle denoted as Point “A”, is just upstream of
Warner’'s Gap Hollow dam reservoir.

Using the zoom bar on the left of the map, zoom in and out (change scale).
v' Another way to find the sampling site elevation (secondary method)

e Zoom in to better locate cursor on site; under the “Standard” tab above map,
select the map navigation icon to reposition the sample site if necessary

¢ Still under the “Standard” tab, click on “Spot Elevation” icon to make it the active
tool

¢ Now, move arrow cursor to sampling site location on the unnamed tributary.
Click to determine elevation.

v' What is the county and state of the sampling location?

To find this information, you must select layers in the “Overlays” tab on the far
left. (If the “Overlays” box did not open when you entered the lat/long coordinates, click
on the “Overlays” tab at the left top of viewer). Overlays provide the data layers to the
map, such as Topo maps, elevation contours, and hydrography information.
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In the “Overlays” box, make sure that the “Content” sub-tab is open (blue
highlighted).

Select “Government Unit Boundaries” by checking the box (checked boxes are
the map’s active layers); county and state boundaries will appear after loading.
Several names will appear, with the county and state highlighted. If you have
difficulty determining the state and county designation, click on the “plus” box '+
on the far left by “Government Unit Boundaries”, click on '+ next to “Labels”, and
deselect every box under Labels except the County and two State boxes.

Record the Answer on your Data Sheet, Appendix 2

Find the USGS topographic map name that contains the sample site

Deselect “Government Unit Boundaries”. Select the “US Topo Availability” layer
by checking the adjacent box; once layer is loaded, the topographic quadrangle
name appears in white letters on the green background. Record the Answer on
your Data Sheet, Appendix 2

NOTE: If you want to remove the green background, expand the “US Topo
Availability” by clicking on the * icon to the left of the box; then deselect “Index
of Available Maps”.

Trouble-shooting note: if the viewer does not respond in a fairly short
period of time, you may have to close-out previously opened layers or even
restart the web browser. If you have problems loading any layer, then
change scale and re-try.

v" Find water body codes (HUC, reach codes)

Hydrologic Unit Codes (HUC)

The USGS organizes watersheds or drainage basins of the United States into a

hydrologic system that divides and subdivides the country into successively smaller
watersheds. These levels of subdivision, used for organization of hydrologic data, are
called "hydrologic units." Numerical codes, called "hydrologic unit codes (HUC)," are
associated with these units. The hydrologic unit codes describe the relation among the
hydrologic units to represent the way smaller watersheds drain areas that together form
larger watersheds.
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Agencies use HUCs for:

* managing natural resource data,;

« presenting stream survey and monitoring results;
« storing and retrieving water quality data;

* mapping land cover

Regions are the largest watersheds shown. Regions contain either the drainage
areas of a major river, such as the Missouri region, or the combined drainage areas of
several rivers, such as the Texas-Gulf region. Regions are identified by 2 digit
codes.

Regions of the United States

Subregions divide the regions and they include the area drained by a river
system, a section of a river and its tributaries in that reach, a closed basin(s), or a
group of streams forming a coastal drainage area. Subregions are identified
by 4 digit codes.

Basins (or Accounting units) subdivide many of the subregions. They are used
by the USGS for managing national water data. Basins are identified by 6 digit
codes.

Subbasins (or Cataloging units) are larger than 700 square miles in area. A
subbasin is a geographic area representing part or all of a surface drainage
basin, a combination of drainage basins, or a distinct hydrologic feature.
Subbasins are sometimes called “watersheds” as in EPA’s Surf Your Watershed
(example: Conococheague-Opequon Watershed). Subbasins are identified by
8 digit codes.
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Watersheds are identified by 10 digit codes.
Subwatersheds are identified by 12 digit codes.
Hydrologic unit codes are from 2 — 12 digits. A HUCS8 (subbasin or cataloging

unit) is 8 digits. For example, Nyes Run in the Susquehanna River drainage in
Pennsylvania is a part of the subwatershed identified by the code:

020503050905

Region = 02

Subregion = 0205

Basin = 020503 (Accounting unit)

Subbasin = 02050305 (Cataloging unit, EPA watershed)
Watershed = 0205030509

Subwatershed = 020503050905

EPA Reach Codes

The National Hydrography Dataset (NHD) is a digital (computerized) collection of
points, lines and polygons that represent surfacewater features, such as streams, lakes
and swamps. Simply put, the NHD can be thought of as 'the blue lines on a map'. The
NHD addressing system employs a unique, standard identifier, known as the reach
code, for each segment of water across the country. Reach codes provide the
foundation or common ‘language’ supporting integrated surfacewater analysis between
EPA Water Programs, states, tribes and other users. Reach codes contain 14 digits.

A reach is the portion of a stream between two points of confluence. A
confluence is the location where two or more streams flow together. In the NHD
addressing system, a reach code identifies each reach in the same manner that a street
name identifies each street. Reach codes are comprised of the 8-digit EPA watershed
code followed a 6-digit arbitrarily-assigned sequence number.
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Using the reach coding scheme, we can see that watershed 01080105 contains the five
reaches:

- 01080105000001
- 01080105000002
- 01080105000003
- 01080105000004
- 01080105000005

01080105

<) -Watershed - 01080105
e = WHD stream network
2  -Reach number - 000002
0  -cConfluence

Position along a reach is determined relative to the reach extent. The downstream end
of a reach is labeled as 0% and the upstream end as 100%. If a monitoring site, for
instance, lies halfway along a reach, its position is 50%.

Start “Hydrography (NHD) data layer:

e Under “Overlays”>"Content’> select the “Hydrography (NHD) data layer.
e Deselect the layers “Government Unit Boundaries” and “US Topo Availability”
under the “Overlays” tab by clicking in the box next to the layer title.

First thing you’ll notice is more complete stream delineation by blue flow lines and
stream names. Reaches are delineated by triangles. The triangles point in a
downstream direction.

e Go back to “Standard Tab” in the menu bar. Make “Identify” icon the active tool
(click on the icon). When you select “Identify”, a drop-down list notes the layers
that will be identified.

e Click down somewhere on the reach containing the sampling site, hold and move
cursor to form a rectangle within the reach (reach ends denoted by triangles); let
go and the NHD information will load (The reach containing the sampling site is
outlined in green).

The map is now filled with green hash lines. In the left window, are listed HUCs from 2
digit (hydrologic unit: Regions) to 12 digit (hydrologic unit: Subwatersheds).

The HUC 2 - 12 digit divisions are colored alike. Regional boundaries are purple lined
and HUC codes are in purple text. The selected region is purple/green hashed. Now,
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identify and better delineate the hydrologic units (HU) from Regional to Subwatershed
level for the sampling site.

Make sure that “Map Navigation” is active tool.
Under “Selection” tab of the left window, click on “Zoom To” under the Region 02;
you'll see the entire region.

o Region 02 is bordered by purple/green hashed lines and the Region’s
HUC 4s begin with “02”

o Similarly, the other Region 02 HUs are identified with a letter and code in
the left-hand window; you will see them located on the map by letter at the
regional scale.

Note: if you click on the map, you may change the hydrologic units selected; if
that happens, click on the “Clear” link in the upper right-hand corner and search
again for the sampling site and redo the “identify hydrologic units” procedure
above.

In left-hand window, click on “Zoom To” under the Subwatershed (12-digit HU);
change Subwatershed color from green to your choice by clicking on the down
arrow on the Subwatersheds bar above; a palatte of colors appear to choose
from.

To calculate area of the Subwatershed, click on the Subwatershed 12-digit HUC
in the left-hand window. A box will appear that lists the HUC number and name;
at the bottom of the box, click on “More” and then click on “Get Area” in the drop-
down menu.

Continue to successively larger hydrologic units by clicking on “Zoom To” under
each, from Watershed to Region, and change the color of each as you go. No
area data will be given for HUC 2 and 4.

You can click on the “Zoom To” under each HUC division to see the geographic
depiction of each hydrologic unit.

Note: For this Subregion, there is only one Basin, therefore the Subregion and Basin
are the same geographic area and the Basin is not listed.

v List HUCs and their names and areas:

Another way to locate the name of each HUC2 — HUCS8 in the Region, go to:

http://water.usgs.gov/GlIS/regions.html

(Hint: the site is in HUC 02 Mid-Atlantic Region)

Note: areas are only listed for HUC4, HUCG6, and HUCS.

Determine area of the Subregion HUC 0207
Note: area for the region has to be obtained by summing Subregion areas
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Return to the USGS National Map Viewer at:
http://viewer.nationalmap.gov/viewer/

You can practice determining areas by tracing the boundary of a HUC unit (try
Subwatersheds) with the Measure Area tool (under the “Advanced” tab; make it the
Active tool).

e “Zoom To” so the entire HUC division, as the Subwatershed, is visible. Follow
the Subwatershed boundaries. To change direction, click once; to finish, click
twice. Once you double-click, the area measured is filled in and area
measurements appear.

Note: if you incorrectly delineate the area, then you must clear graphics and identify
hydrography information again. (A bit inconvenient).

Record the Answers in the chart provided on your Data Sheet, Appendix 2

v' Determine the EPA Reach Code for the sample site (also stream name,
class, and length)

Clear map (note that NHD layer is still present or active)

Center sample site (search on lat/long coordinates and then “Zoom To” site)

Go to the “Standard” menu bar (on top) and make “Identify” the active tool

In the “Identify Layers” tab on the left, deselect all layers except “Flow line large

scale and small scale ”

e Next, with “Identify” active, click, hold, and draw a rectangle on the reach
containing the sample site

e After loading, the selected reach will be outlined in green, delineating the reach
between triangles (which themselves usually are at confluences)

¢ In the left window, under Selection > Results tab, click on the stream name
(“Null” denotes an unnamed reach); Use only result “A”

e A box will appear on the map, pointing to the stream reach that will provide the
14-digit reach code, steam length, and the stream name (GNIS ID).

¢ You can draw a rectangle on any reach visible on the map viewer to determine

the stream name and reach code.

Record the Reach Code & Reach Length on your Data Sheet, Appendix 2

e Click on other upstream and downstream tributaries to see additional reaches
and reach codes; if the reach is named, the GNIS ID will be listed as a link; click
on the GNIS ID and you will be taken to a new window having additional
information on that reach
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Google Earth can be a good communication tool to share sample site location data. For
example, open Google Earth and enter the lat-long coordinates for our sample site
(39.6611 -77.5463) in the search box upper left. You should get this:

= Googhe Farth
Bl ER Yew ook A1 teb
v Search

FyTo | PdBusnesses | Dvechons

36611 775463

Click on the “Add Placemark” | _** |. A “New

[ Placemark” box and a yellow location placemark
on the map will appear. In the box, the

Latituds: | 39.661100° | coordinates will be automatically filled. If, under
Longtude: |-77.545300° | Tools>Options, the Decimal Degrees radial
button is selected, then the coordinates listed will
be Latitude and Longitude. However, if the
Descrintion. | Style, Calor | View || Aituce Universal Transverse Mercator radial button is
selected, coordinates will be in UTMs. Next, type
in “Warner Hollow branch sample site 1”7 in the
Name box. You can enter a description as “Just
upstream of Edgemont Reservoir” in the
Description tab. Click “OK”.

Mame: | kil

d Placemark

[ addlink... | [addimage...

K, ] [ Cancel
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Placemark indicating the sampling site.
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To save the location on your hard drive, in the upper left corner, click on
File>Save>Save Place As...

A “Save As” box will appear. You can change the name of the file. The extension is
“.kmz”. This file can be double-clicked which will open Google Earth and take the view

to the sampling site. This .kmz file can be emailed for others to view your sampling
location.

v' Determine “Impairment Status”
We will leave The National Map Viewer and use another Viewer entited MyWATERS

Mapper, an EPA application. Go to:

http://watersgeo.epa.gov/mwm/

e Click link at bottom to launch the mapper if not launched automatically;

e Enter the following sampling site latitude and longitude coordinates (numbers
and negative sign only) into the “Go To” bar on left. Make sure the selection
immediately below is “Address or Location”. Click on “Go”.
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Latitude 39.6611° N and Longitude -77.5463° W

e Sample site should be centered in view and briefly show as a red dot with
coordinates. The site indicator will disappear® . You can click on the “Go”
button and the indicator will reappear but will not remain visible.

e On the right, click on the “Other EPA Water Data” menu bar. Check “Rivers and
Streams (NHD)”, “Watershed Boundaries (WBD)”, and “Impaired Waters” (see
following image) on the drop down menu.

MyWATERS Mapper dynamically displays snapshots of EPA Office of Water program data. This version of MyWATERS Mapper depicts the status of NPDES permits for each Stat
summary information from the Clean Watershed Needs Survey, and water quality assessments. Future versions will include other Office of Water Program Snapshots. MyWAT!
Mapper also contains water-related geographic themes such as 12-digit watersheds, the national stream network known as the National Hydrography Dataset, and other wa
related map layers. MyWATERS Mapper enables you to create customized maps at national and local scales.

"
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e The NHD streams will be either blue or red lined. At this scale, HUC12
subwatershed boundaries will be visible (purple colored). To see larger
hydrologic units, use the zoom bar on the left to zoom out. Finally impaired
streams will be outlined in red. To see what category of impairment, click on the
“Water Impairments” bar and select “Pathogens”. Click the “Show Impairments”
bar. Streams impaired by pathogens will be bolded red. Follow the same
process for “Nutrients” and finally “Sediment”.

e By double-clicking on or near the sample site, a “Features of this Location” box
will appear. There are sub-boxes that contain information on the stream reach
(“Flowlines”) and the Subwatershed (HUC12), including the name that you can
record on appendix 2. Under the “Flowlines” bar at the top, if the reach is named,
the reach name will appear next to “Name”. Other information includes
waterbody type, reachcode, HUC12, and reach length.

NOTE: The stream reaches designated by the NHD Reachcodes are determined
differently than those by the USGS National Map, so get the reachcode and reach
length values from the USGS National Map.
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Features at this Location
There are 4 features at thiz location,

Zoom in Closer

RETH

Feature ID:
Database ID:
Type:

NHD Reachcode:

Hydrologic Unit Code (HUL 12): 041004

Length (km): 3.074

In Metwork: v

D|'III'IESI !E! ! !
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e Tolocate STORET Water Monitoring stations near the sampling site, click on the
“Other EPA Water Data” bar, and check the box next to “STORET Water
Monitoring stations”. Station locations will appear as a blue water drop. Go to
the “Water Monitoring Data” bar, click on “Get Sampling Results for Specific
Locations” (nothing much apparently happens), and then draw a
rectangle/square around a water quality monitoring station. These actions will
bring up information about that station and data download links to STORET
(storage and retrieval).

e Back to our sample site on an un-named tributary of Little Antietam Creek, is this
reach designated as “impaired water”? Remember that when the “Impaired
Waters” box is checked, impaired reaches will highlight in red.

e Please explore this mapper for additional information. Once satisfied, you may
close the mapper.

Record any impairments on your Data Sheet, Appendix 2

Regional Setting

Regional setting influences the physical structure (geomorphology) and biological
structure of a stream reach. As such, regional setting attributes can be used to stratify
streams into categories for sampling design or analysis.
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e Regions represent broad patterns of climate and geology and influence many
properties of aquatic habitats (hydrology, substrates, morphology, etc.).

e Aregion is recognized as having aquatic habitats that are more similar to each
other than they are to habitats in other regions.

e When working with large spatial scales, recognizing groupings of similar habitats
helps a biologist establish benchmarks for habitat potential and lowers variability
in data.

Regional classification systems often are hierarchical.

e Regional management must consider multiple spatial scales to accommodate
aquatic systems.

e Series of levels organized so that finer classified regions nest within the next
larger class.

e These classification systems provide a stratification framework that can reduce
data variability thereby improving power of projects to detect trends or
differences.

Example of a hierarchical structure in spatial frameworks (Bailey’s Ecoregion System)

DOMAINS

Regional Settings include such classification systems as

e Physiographic provinces
e Hydrogeomorphic regions
e Ecoregions
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Physiographic Provinces

Based on: TOPOGRAPHY (mountains, plains, plateaus, uplands) and GEOLOGY
(rock type and geologic structure and history)

» Hierarchical, 8 major divisions, 25 natural subdivisions (provinces)

Differ in climate, vegetation, surficial deposits and soils, water supply,
mineral resources

« Boundaries between provinces are often sharp

» Used to identify fish distributions

An Example of Physiographic Provinces Contained Within a State

Appalachian Blue
Plateaus Ridge and Valley Ridge
Province Province Province Piedmont Plateau Province
. __ Vi

177 7

Folded Appalachian

Western Shore
Mountains Section Lowlands
Region
Delmarva
Physiographic Provinces Peninsula
. Region
and Their
Subdivisions in Maryland Atlantic
Continental
Shelf
s ™ e ™ .
1] miles 50 Province

Province Boundary
Subdivision Boundary

Maryland Geological Survey
January, 2001

hitp: e mgs.md.gov

Coastal Plain Province
Embayed Section

The Physiographic Province system may be subdivided into successively smaller units:
Major Division > Province > Section > Region > District > Area

(Note: different terminology is sometimes used; e.g., “subprovince” used for “Section”)
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For example, a stream site in Maryland might be classified as within the

Applalachian Highlands Division
Blue Ridge Province
Northern Blue Ridge Section
Middletown Valley Region
Lower Middletown Valley District
Catoctin Creek Gorge Area

Practical Exercises: for the following exercises please refer to the resource maps
located at:

http://nctc.fws.gov/courses/csp/csp3200/resources/index.html

v" Find the physiographic province, section, and region of the sample site on
the un-named tributary of Little Antietam Creek. Use the Physiographic
Map of Maryland (note that the sample site location is indicated by an
arrow). You may save as a .pdf for better viewing or just use the zoom
function at the bottom right corner.

Record the Answer on your Data Sheet, Appendix 2

*Note: For a narrative description of the physiographic province characteristics, see
James P. Reger, J.P. and ET. Cleaves. 2008. An Expanatory Text for the
Physiographic Map of Maryland. Open-File Report 08-03-01 Map of Maryland
Description. You'll see an overview of the physiographic region classification
system starting on page one and a brief description of the Blue Ridge Province
on page 5.

Hydrogeomorphic Regions

e Used for stratifying ground-water discharge patterns and wetland functions
e Based on lithology (rock type) and physiography based on geologic formations

Open Hydrogeomorphic Regions which maps the hydrogeomorphic regions of the
Chesapeake Bay watershed.

v What hydrogeomorphic region is the sample site located in?

Record the Answer on your Data Sheet, Appendix 2
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Ecoregions

Relatively uniform areas defined by several key geographic variables (physical and
biotic)

e such as, geology, landform, soils, vegetation, climate, wildlife, land use
¢ hierarchical classifications (broad scale to fine scale)

Ecoregions are used to:

¢ identify the natural characteristics and potential of aquatic systems;

e determine regional boundaries to set benchmark biotic potential and to measure
and evaluate aquatic system integrity against the appropriate benchmark;

e establish water quality standards;

e stratify sampling sites;

e extrapolate to regional information from site-specific studies

2 commonly used classification systems:

Bailey’s (provides a broad synthesis of ecosystem geography of the US)

Omernik’s (provides a classification for regionalizing water resource management
and for distinguishing regional patterns of WQ in ecosystems as a result of
land use)

For this class, we will use Omernik’s Ecoregion classification system.

e A classification for regionalizing water resource management
e Used to distinguish regional patterns of water quality due to land uses
e Found to correspond well to spatial patterns of water quality and fish distribution

Hierarchical:
Level | (15 ecoregions in North America)
Level Il (50)
Level Il (182; descriptions include landforms, potential vegetation, land use,soils)
Level IV (NA coverage not comprehensive)
v List Omernik Ecoregion levels I, 11, lll, and IV for the sample site

o For all Ecoregion levels, select the appropriate link on the course page
under the Resource Maps section. View the pdf or download the maps

http://nctc.fws.gov/courses/csp/csp3200/resources/index.html
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Note: You can zoom in and out in maps.

Record the Answers on your Data Sheet, Appendix 2. Note: Level IV is hard to
distinguish in the area of the site.

See also the description of the Level Il Ecoregions for the continental U.S. in:
Eco Level Ill Descriptions
For both Level Il and Level IV Ecoregion descriptions for the sample site, see

EPA Region 3 Eco Description

Catchment Basin Characteristics

A sample site’s catchment is all the stream
segments upstream of the sample site and all
of the land that drains into those streams.
The topographic watershed boundary runs
along ridges (“divides”).

i Licriuck

From Rivers of Alabama

Catchments are nested: here’s an example with sample sites denoted as red circles,
and catchment areas as dashed lines-

Important catchment attributes,
« Size (e.g., acres, hectares, square miles)

« Geomorphic properties (e.g., basin length and relief, drainage density and shape)
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» Stream size of reaches (e.g., stream order)
« Land cover (e.g., geology, soils, vegetation, and land use in area & proportions)

Catchment basin attributes influence hydrology (water yield and pattern of floods) and
sediment yields; both factors influence stream morphology and in-stream habitat.

Catchment basin size
Importance of catchment basin size include:

e A factor behind geomorphological attributes as bankfull discharge, mean
depth, width, and cross-sectional area (i.e., stream size and shape).

e Drainage basin size often used to match study sites; for example, comparing
similar-sized impaired sites to reference sites

e Assume similar sized stream sites have similar potential (e.g., fish species
richness), other factors being equal

Catchment basin size can be determined by

e U.S. Geological Survey topographic maps (e.g., scale of 1:24,000 or 1
distance unit on map equals 24,000 distance units on ground)

e or more commonly, Geographic Information Systems (GIS) or map viewers
Some basics,
Topographic map features:

e blue lines = streams
— solid lines = perennial streams
— dashed lines = intermittent streams
e brown lines = contour lines
— form “V’s where they intersect streams (“M’s above stream junctions);
“V”s point upstream
— topographic high points marked by ring
e Headwater streams = streams with no tributaries

Note: It is important to realize that blue lines may not be an accurate representation of
the spatial extent of perennial or intermittent streams. Aquatic macroinvertebrate taxa
that require perennial water have often been found “above the blue line” in Appalachia.
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USGS Topographic Map

7.5 minute series, 1:24,000 scale

A
ﬁ E.}i:f_lgg}’%’ ﬁ_f#

Determining a topographic catchment basin
e locate all upstream tributaries that contribute flow through study site
e |ocate headwaters to determine top of drainage basin

¢ determine approximate location where surface run-off splits flow into and away
from basin

e connect topographic high points
e draw drainage divide perpendicular to each contour line it crosses

e on flat areas, divide in half the area between streams
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Example of a catchment basin for a sampling site on Virgil Creek
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v' Determine the catchment basin size in square miles for the sample site on
the un-named tributary of Little Antietam Creek.

Open the USGS The National Map Viewer:

http://viewer.nationalmap.gov/viewer/

e Enter the sample site location coordinates: Latitude 39.6611° N and Longitude
-77.5463° W

e Under “Overlays” > “Content”, select “Elevation Contours”; to enhance the blue
flow lines, select the Hydrography (NHD)

e Zoom closer until the catchment basin is as large as you can get without going
off the screen (e.g., scale of 1:72,224 or even 1:36,112); you can measure the
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area of a catchment that has part of the area off the screen but we won’t tackle

this for the first attempt at area measurement

e Go to the “Advanced” tab, and select the “Measure Area” tool E

e Start at the sample site (click once) and begin to outline the topographic
catchment basin; each time you must change directions, click once; when you
have totally outlined the catchment boundaries, double click. The catchment you
outlined will fill in red and an area box will appear that includes area in square

kilometers and in square miles.

e You can zoom in closer (e-g-, Standard = Advanced = Annctation = Active Tool: Measure Area

scale 1:36,112) to make sure |~ G s 9

—

your catchment boundaries 7
followed the topographic iy
divides; add more area to the | **
catchment if needed,; if your 7
catchment is too large (you
included area from adjacent
topographic catchments), you
can start over or measure the
area of the adjacent
catchments included in your
catchment for the sample site,
then subtract that area from
your total catchment area

(ERR RN R

Record your answer on your Data Sheet, Appendix 2

Click to start

|
{Toms
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v" Plug your catchment size (in square miles) into the regional curves listed
below. Either estimate from the graph or enter the sampling site catchment
area into variable “DA” of the prediction equations. Determine expected
bankful discharge, cross-sectional area, width, and mean depth for the

sample site.
10000 &
T
1000 £ /‘
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Record your answers on your Data Sheet, Appendix 2
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Steam size

Stream size can be characterized in several ways, including by catchment size,
average stream width, or by stream order (Strahler, Link Magnitude, D-Link, C-Link, and
B-Link). Stream size is important for determining biotic potential of streams. Larger
streams support more species of fish, for example.

Position of streams in the larger watershed can be described by the link system.
Position also can be an important determiner of species richness.

Stream order:
The oldest and most commonly used is Strahler stream order (Strahler 1957).
e headwater streams = 1st order

e 2 streams of order n form a stream of ordern + 1

e 2 streams of different orders -- the stream they form does not change
order (below confluence, stream order is the higher of the two parent
streams)
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Stream Order: Link Magnitude (Shreve 1966)

e Link magnitude is the number of un-branched source streams
upstream of a given segment in the drainage network.

e Think of it as a “finer-grained” stream size metric than stream order
(used more in benthic invertebrate work

-
]

e The Link Magnitude number of a reach indicates how many
tributaries are upstream of the reach.

Stream Order: D-Link

e Osborne and Wiley defined D-link as the link magnitude of the next
downstream segment from the segment in question.

e Emphasizes differences of small streams in upper watershed vs.
small streams directing joining much larger streams. Reason:
similar sized streams could have different fish faunas depending
upon where they link up to the stream system.

e “Adventitious streams” are small streams that join much larger
streams (have small link number and large D-link number)

e First determine Link Magnitude for a drainage. Then “shift up” the
rating from the lower to the adjacent upper reaches (= D-Link).
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For example,

Undefined

Link Magnitude D-Link

Now, use more complicated drainage examples of Link magnitude and D-Link to
illustrate D-Link application.

Link Magnitude D-Link

ndefined

15

14

v" Print out the catchment for the sample site in the USGS map viewer or
make hand sketches of the drainage. Determine Strahler stream order,
Link Magnitude, and D-Link for each stream reach. What is the Strahler
stream order, Link Magnitude, and D-Link values for the reach at the
sample site?
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Geomorphic Properties

Several geomorphic properties of catchments are listed and explained in Appendix 3
Geomorphic Properties Exercises. Use the USGS The National Map Viewer to
estimate these properties. Use the “Measure Distance” and “Spot Elevation” tools and
record your answers.

kkkkkkkkkkkkkkkkkkkhkkkkkkkkhkkkkkkhkkkhkkkkkkkkkkkkkhkkkhkkkkkkkkkkkkhkkkhkkkkkkkhkkkkhkkkhkkkhkkkhkkhkkkkkkkkkkhkkhkkkkkkkkk

Now that you have completed the example exercise for the unnamed tributary of
Little Antietam Creek, go through the same process to characterize our class field
trip site (note: the sampling site is in Virginia). Complete Appendix 2 Sample Site
Identification, Regional Setting, Catchment and Reach Size Data Sheet and
Appendix 3: Geomorphic Properties Exercises for the Sweet Run site. An aerial
photo and topo map for “Sweet Run” and a Physiographic Map of Virginia are
located at:

http://nctc.fws.gov/courses/csp/csp3200/resources/index.html

Note: the field trip site is designated as “degraded reaches” on the photo and topo.

The Field Site Location (Sweet Run) coordinates are:
Latitude 39.2835° N, Longitude -77.741476° W

Answers will be discussed during the webinar. We will be using this information as part
of our analysis of the sampling site.
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Appendix 1: Universal Transverse Mercator Geographic Coordinate System

The Universal Transverse Mercator (UTM) geographic coordinate system is a grid-
based method of specifying locations on the surface of the Earth that is a practical
application of a 2-dimensional Cartesian coordinate system. It is a horizontal position
representation, i.e., it is used to identify locations on the earth independently of vertical
position, but differs from the traditional method of latitude and longitude in several
respects.

The UTM system divides the surface of Earth between 80°S and 84°N latitude into 60
zones, each 6° of longitude in width and centered over a meridian of longitude. Zone 1
is bounded by longitude 180° to 174° W and is centered on the 177th West meridian.
Zone numbering increases in an easterly direction.

UTM Zones in the Northern and Western Hemisphere
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Each of the 60 longitude zones in the UTM system is based on a transverse Mercator
projection, which is capable of mapping a region of large north-south extent with a low
amount of distortion.

An Earth location is defined as a point with x and y coordinates. In the UTM system, the
terms easting and northing are geographic Cartesian coordinates for a point. A position
is referenced by the UTM zone, and the easting and northing coordinate pair. The
easting is the projected distance of the position eastward from the central meridian,
while the northing is the projected distance of the point north from the equator (in the
northern hemisphere). Eastings and northings are measured in meters. The point of
origin of each UTM zone is the intersection of the equator and the zone's central
meridian. In order to avoid dealing with negative numbers, the central meridian of each
zone is given a "false easting" value of 500,000 meters. Thus, anything west of the
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central meridian will have an easting less than 500,000 meters. For example, UTM
eastings range from 167,000 meters to 833,000 meters at the equator (these ranges
narrow towards the poles). In the northern hemisphere, positions are measured
northward from the equator, which has an initial "northing" value of 0 meters and a
maximum "northing" value of approximately 9,328,000 meters at the 84th parallel — the
maximum northern extent of the UTM zones. In the southern hemisphere, northings
decrease as you go southward from the equator, which is given a "false northing" of
10,000,000 meters so that no point within the zone has a negative northing value.

As an example, the CN Tower is located at the geographic position 43°38'33.24"N,
79°23'13.7"W or 43.6425667°N, 79.387139°W or 43.6425667, -79.387139. This is in
zone 17, and the grid position is 630084m east, 4833438m north. There are two points
on the earth with these coordinates, one in the northern hemisphere and one in the
southern. To define the position uniquely:

e Append a letter designator to the zone number, in this case "T" (see previous
figure), thus "17T 630084 4833438".

Exercise-

Go to UTM converter http://www.dmap.co.uk/ll2tm.htm

Enter Degrees, Minutes, and Seconds for the stream site location. Then choose grid
area UTM (WGS84 datum) and the calculate button for determining the central meridian
longitude. Finally, click convert to finish calculation.

Your answer will be in easting and northing (X,y) coordinates (281507, 4393344); the
grid reference is 18STJ 81507 93344. The first number of the grid reference number is
the UTM zone. You would report your location as 18S 281507m E 4393344m N.

Notice that the central meridian of zone 18 is 75° W longitude, because the eastern
boundary is 72° W and the western boundary is 78° W.

UTM Zones in the Continental United States

126°W 120°W 114°W 108°W 102°W 96°W 90°W 84°W 78°W 72°W 66°W

Red star denotes approximate
location of stream sampling site.
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Appendix 2: Sample Site Identification, Regional Setting,
Catchment and Reach Size Data Sheet

Investigator: Date:

Position Identification

Stream name/Study site name:

Latitude Longitude Elevation

Grid Reference

Zone UTM

County State

USGS Topographic Map Name

Water Body Coding

USGS catalog unit (HUC-8, sub-basin, EPA watershed)

Division HUC Name Area

Region N/A

Subregion

Basin

Subbasin

Watershed

Subwatershed

USEPA reach code Reach Length

Water Impairments:

Regional Setting
Physiographic Province code/name:

Section code/name (or subprovince):

Region code/name:

District code/name: N/A
Area code/name: N/A

35 USFWS-NCTC



Stream Habitat Measurement Techniques

U.S. Fish and Wildlife Service, National Conservation Training Center

Hydrogeomorphic region:

Ecoregions:

Omernik Level |

Omernik Level Il

Omernik Level Il

Omernik Level IV

Catchment (“Drainage”) Basin Characteristics

Catchment area

Bankfull discharge

Cross-sectional area

Width

Mean depth

*Reach type (e.g., Rosgen classification)

Reach size:

*Average bankfull width

Strahler Stream Order

Link Magnitude

D-Link

* Stream classification and average bankfull width will be determined after field data

collection.
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Appendix 3: Geomorphic Properties Exercises

Once the catchment divide is drawn on a map and the area has been estimated, the
geomorphic properties can be estimated, measured, or computed. Each of the
geomorphic properties listed below includes a definition and explanation of its
importance to catchment characterization. The downstream boundary of the catchment
is the sample site.

1. Main channel slope: Main channel slope is an estimate of the typical rate of
elevation change along the main channel that drains the catchment. This
measurement is often related to peak flow magnitude and flood volume. Estimate
the main channel slope by measuring the length of the main channel from the
study site to the mapped source of the main stream. At each stream channel
bifurcation, follow the fork with either the higher stream order number or the
longer pathway to a stream source. Mark off 10% and 85% of the main channel
length on the map. Estimate the elevation in meters at the 10% and 85%
distance points, using the contour lines on the topographic map. Compute the
main channel slope as follows:

Slope = (elevation at 85% length — elevation at 10% length) / 0.75 (main channel
length).

ANSWER:

2. Total stream length: Total stream length is the sum of the lengths of all
perennial streams within a catchment as shown on a topographic map.
Determine the total stream length by measuring the length of each perennial
stream section with a map measurer. Sum these individual stream lengths. The
summed stream lengths determine the total amount of stream habitat in a
catchment and the availability of sediment for transport.

ANSWER:

3. Catchment length: Catchment length is estimated as the straight-line distance
between the stream site and the drainage divide nearest to the source of the
main stream [see “Main Channel Slope” description to find out how to delineate
the main stream}. Catchment length is used to calculate drainage shape.

ANSWER:
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. Catchment relief: Catchment relief is the difference in elevation between the

highest and lowest points in the catchment. It controls the stream gradient and
therefore influences flood patterns and the amount of sediment that can be
transported. Sediment load increases exponentially with catchment relief.

ANSWER:

. Catchment relief ratio: The catchment relief ratio index is the catchment relief

divided by the catchment length. It is useful when comparing catchments of
different sizes because it standardizes the change in elevation over distance.

ANSWER:

. Catchment surface storage: The percentage of the catchment covered in lentic
and impounded water bodies, including wetlands (optional), reflects the surface
storage capacity of the catchment. Determine the catchment surface storage by
measuring the area of each lake or impounded water body. Wetland areas will
have to be estimated because the borders are not delineated on topographic
maps. Add all water body and wetland areas and divide this sum by the drainage
area.

ANSWER:

. Drainage density: An index of the length of stream per unit area of catchment is
calculated by dividing the total stream length by the drainage area [see #8]. This
ratio represents the amount of stream necessary to drain the catchment. High
drainage density may indicate high water yield and sediment transport, high flood
peaks, steep hills, low suitability for agriculture, and high difficulty of access.

ANSWER:

. Drainage shape: An index of drainage shape is computed as a unit less
dimension of drainage area divided by the square of catchment length. It
describes the elongation of the catchment and is useful for comparing
catchments. If two catchments have the same area, the more elongated one will
tend to have smaller flood peaks but longer lasting flood.

ANSWER:
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Appendix 4: Answers to Questions

Sample Site Identification, Regional Setting, Catchment and
Reach Size Data Sheet

Position Identification

Stream name/Study site name:___unnamed tributary of Little Antietam Creek

Latitude _ 39° 39' 39.9594" N Longitude _-77° 32'46.68" W Elevation __936

Grid Reference 18STJ 8156493243

Zone 18S UTM 18 281564m E 4393243m N
County _ Washington State Maryland
USGS Topographic Map Name Smithsburg

Water Body Coding

USGS catalog unit (HUC-8, sub-basin, EPA watershed)

Division HUC Name Area

Region 02 Mid-Atlantic N/A
Subregion 0207 Potomac 14,600 mi”
Basin 020700 Potomac 14,600 mi”
Subbasin 02070004 Conococheague - Opequon | 2,278.9 mi°
Watershed 0207000410 Antietam Creek 290.9 mi
Subwatershed | 020700041004 | Little Antietam Creek 24.7 mi°

USEPA reach code 02070004002574 Reach Length 1.184 km

Water Impairments None

Regional Setting

Physiographic Province code/name: ___ 300000 Blue Ridge Province

Section code/name (or subprovince): __ 310000 Northern Blue Ridge Section
Region code/name: 312000 Catoctin-South Mountain Region

District code/name: N/A

Area code/name: N/A
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Hydrogeomorphic region: Blue Ridge

Ecoregions:
Omernik Level | Eastern Temperate Forests (8)
Omernik Level Il ___Ozark, Ouachita-Appalachian Forests (8.4)
Omernik Level 1ll __Blue Ridge (66)

Omernik Level IV Northern Sedimentary and Metasedimentary Ridges (66b)

Catchment Basin Characteristics

Catchment area 2.426 square miles or 6.284 sguare kilometers

Bankfull discharge 70 cfs
Cross-sectional area 23 ft2
Width 19 ft
Mean depth 1.2 1t

*Reach type (e.g., Rosgen classification)

Reach size:

*Average bankfull width

Strahler Stream Order 2

Link Magnitude 6

D-Link "Undefined”

* Stream classification and average bankfull width will be determined after field data
collection.
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Geomorphic Properties Exercises (answers)

Once the catchment divide is drawn on a map and the area has been estimated, the
geomorphic properties can be estimated, measured, or computed. Each of the
geomorphic properties listed below includes a definition and explanation of its
importance to catchment characterization. The downstream boundary of the catchment
is the sample site.

1. Main channel slope: Main channel slope is an estimate of the typical rate of
elevation change along the main channel that drains the catchment. This
measurement is often related to peak flow magnitude and flood volume. Estimate
the main channel slope by measuring the length of the main channel from the
study site to the mapped source of the main stream. At each stream channel
bifurcation, follow the fork with either the higher stream order number or the
longer pathway to a stream source. Mark off 10% and 85% of the main channel
length (feet or meters) on the map. Estimate the elevation in feet or meters at the
10% and 85% distance points, using the spot elevation tool or the contour lines
on the topographic map. Compute the main channel slope as follows:

Slope = (elevation at 85% length — elevation at 10% length) / 0.75 (main channel
length).

ANSWER: 442m — 286m / 0.75(3828.6m) = 0.54, 5.4%

2. Total stream length: Total stream length is the sum of the lengths of all
perennial streams within a catchment as shown on a topographic map.
Determine the total stream length by measuring the length of each perennial
stream section with the “measure distance tool” or a map measurer. Sum these
individual stream lengths. The summed stream lengths determine the total
amount of stream habitat in a catchment and the availability of sediment for
transport.

ANSWER: 4.522 mi or 7.2775km

3. Catchment length: Catchment length is estimated as the straight-line distance
between the stream site and the drainage divide nearest to the source of the
main stream [see “Main Channel Slope” description to find out how to delineate
the main stream}. Catchment length is used to calculate drainage shape.

ANSWER: 3.548 kilometers - 11,641.448 feet - 2.205 miles
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. Catchment relief: Catchment relief is the difference in elevation between the

highest and lowest points in the catchment. It controls the stream gradient and
therefore influences flood patterns and the amount of sediment that can be
transported. Sediment load increases exponentially with catchment relief.

ANSWER: 936’ - 1826’ = 890’

. Catchment relief ratio: The catchment relief ratio index is the catchment relief

divided by the catchment length. It is useful when comparing catchments of
different sizes because it standardizes the change in elevation over distance.

ANSWER: 890’ /11,641’ = 0.08

. Catchment surface storage: The percentage of the catchment covered in lentic
and impounded water bodies, including wetlands (optional), reflects the surface
storage capacity of the catchment. Determine the catchment surface storage by
measuring the area of each lake or impounded water body. Wetland areas will
have to be estimated because the borders are not delineated on topographic
maps. Add all water body and wetland areas and divide this sum by the drainage
area then multiply by 100.

ANSWER: (.016 mi® / 2.4mi%) x 100 = 0.67%

. Drainage density: An index of the length of stream per unit area of catchment is
calculated by dividing the total stream length by the drainage area. Drainage
density is usually expressed in terms of stream miles per square mile. This ratio
represents the amount of stream necessary to drain the catchment. High
drainage density may indicate high water yield and sediment transport, high flood
peaks, steep hills, low suitability for agriculture, and high difficulty of access.

ANSWER; 4.522 miles/ 2.4 mi’ = 1.89 mi/ mi?

. Drainage shape: An index of drainage shape is computed as a unit-less
dimension of drainage area divided by the square of catchment length. It
describes the elongation of the catchment and is useful for comparing
catchments. A more elongated watershed will have a lower value. If two
catchments have the same area, the more elongated one will tend to have
smaller flood peaks but longer lasting flood.

ANSWER: 2.4 mi’/ (2.205)° = 0.49
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